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Introduction
2

 Computer Stands for Common Oriented Machine

Particularly Used for Trade, Education and

Research.

 Computer can also be defined as Common

Operated Machine Particularly Used for Trade,

Education and Research.



Contd…
3

 A Computer is an electronic device that accepts raw data as input,
can store and processes the data (typically in binary form)
according to a set of instructions (programs) to produce the desired
result (Output) as information.

 Data – Data is defined as an unprocessed collection of raw facts, suitable
for communication and processing.

For Example, Praveen, CS Department, APCAS are data. This will not give
any meaningful data.

 Information is a collection of facts from which conclusions of facts from
which conclusions maybe drawn. In Simple words, data is the raw facts that
is processed to give meaningful , ordered or structured information.

Example: Praveen from CS Department of APCAS. This information conveys
some meaning.
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 Computer data is considered as the information processed or

stored by a computer. This information may be in the form of

text documents, images, audio clips, software programs, or

other types of data.

 An Instruction is a group of bits that define operations such

as add, subtract, multiply, shift and compliment.



Characteristics of a Computer 
5

 The characteristics of computer are high speed of operations,
accuracy, reliability, flexibility, and economy coupled with
efficiency in storing and processing data.

 High Speed: Computers have the ability to perform routine tasks at a
greater speed than human beings. They can perform millions of
calculations in seconds.

 Accuracy: Computers are used to perform tasks in a way that ensures
total accuracy.

 Storage: Computers can store a large amount of information. An item of
data or any instruction stored in the memory can be retrieved by the
computer at lightning speeds.
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 Automation: Computers can be instructed to perform comp)
tasks automatically (which increases productivity).

 Diligence: Computers can perform the same task repeatedly
and with the same accuracy without getting tired.

 Versatility: Computers are flexible to perform both simple
and complex tasks.

 Cost-effectiveness: Computers reduce the amount of
paperwork, and human effort, thereby reducing costs.



Application/ Uses of Computers
7

 Computers are used everywhere. There are several uses of
computers which are as follows.
 Desktop publishing - With desktop publishing, you can create page

layouts for entire books on your personal computer.

 Computers in Medicine - You can diagnose diseases. Software is
used in magnetic resonance imaging to examine the internal
organs of the human body. Software is used for performing
surgery. Computers are used to store patient data.

 Mathematical Calculations - Thanks to computers, which have
computing speeds of over a million calculations per second, we can
perform the biggest of mathematical calculations.
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 Banks - All financial transactions are done by computer software. They
provide security, speed, and convenience.

 Travel - One can book air tickets or railway tickets and make hotel
reservations online.

 Telecommunications - Software is widely used here. Also, all mobile phones
have software embedded in them.

 Defence - There is software embedded in almost every weapon. Software
is used for controlling the flight and targeting ballistic missiles. Software is
used to control access to atomic bombs.

 E-Learning - Instead of a book, it is easier to learn from E-learning
software.
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 Gambling - You can gamble online instead of going to a
casino.

 Examinations - You can take online exams and get instant
results. You can check your examination results online.

 Computers in Business - Shops and supermarkets use the
software, which calculates the bills. Taxes can be calculated
and paid online. Accounting is done using computers. One
can predict future trends of business using an artificial
intelligence software. Software is used in major stock
markets. One can do trading online. There are fully
automated factories running on software.
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 Certificates - Different types of certificates can be generated. It is
very easy to create and change layouts.

 ATM machines - The computer software authenticates the user and
dispenses cash.

 Marriage - There are matrimonial sites through which one can
search for a suitable groom or bride.

 News - There are many websites through which you can read the
latest or earlier news.

 Alumni Associations - There are many alumni websites through which
you can regain contact with your classmates.
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 Robotics - Robots are controlled by software.

 Washing Machines - They operate using the software.

 Microwave Oven - They are operated by software.

 Planning and Scheduling - Software can be used to
store contact information, generating plans, scheduling
appointments, and deadlines.

 Plagiarism - Software is available that can examine
content for plagiarism.
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 Greeting Cards - You can send and receive greetings online,

suiting different occasions.

 Sports - Software is used for making umpiring decisions in

games. There is simulation software by using which sportsperson

can practice his skills. Computers also to identify flaws in

technique.

 Aero planes — Pilots train on software, which simulates flying.

 Weather analysis — Supercomputers are used to analyze

predict the weather.



APPLICATIONS OF COMPUTERS IN DIFFERENT FIELDS 
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Applications of Computers in Education

 Computer education is becoming mandatory in most
universities across the world. They basically teach the subjects
which enable the students to acquire a job in the software
engineering Industry, Teachers use computers as teaching
aids with a provision for spare time to enable students to
interact with teacher at the end of the session. Nowadays,
colleges are setting up such a system where student and
faculty attendance, syllabus, schedule of tests, exams, etc.,
are put on the web, and students, their parents, and faculties
can access it from anywhere and get updated.



Applications of Computers in Industries
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 Mostly, the software or the hardware that is produced
by companies would be used to automate the manual
task. An industry, capable of producing such products is
called the software industry. Other companies that use
these services are called clients. Computers can be used
to produce patterns in textile industries, color
combinations in paint industries, automate the operation
of a machine in an industry using robotics, etc.



Applications of Computers in Business
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 They are used in commercial organizations to accomplish
clerical and administrative work. Tax calculations, salary slip
preparations, etc., can be done using computers. Stock
market predictions can be, done. Banks are using computers
to maintain the accounts and. transactions. E-banking is
picking up popularity because of the flexibility of banking
from an armchair. Excluding the matter of much-talked
security, they are used comfortably by the customers. E -
'Shopping is one more concept gaining popularity in an
industry where a customer can buy the displayed items by
paying through credit card or cash on delivery options.



Applications of Computers in Entertainment
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 Animations and Special Effects for the movies are done
using high-end workstations. In the Titanic movie, they
used 100 high-end Linux workstations in parallel to
produce special effects. Also, the movies and music are
available in the form of CDs, VCDs, and DVDs which
cost less compared to watching movies at theatres.
People prefer to watch them through these media in
their leisure time. Kids enjoy playing games using
computers.



Data Representation
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 Computer data is a piece of information processed or stored by a computer. This

information may be in the form of text documents, images, audio clips, software

programs, or other types of data. Computer data may be processed by the computer's CPU

and is stored in files and folders on the computer's hard disk.

 Computer data is a bunch of ones and zeros, known as binary data. Because all computer

data is in binary format, it can be created, processed, saved, and stored digitally. This

allows data to be transferred from one computer to another using a network connection or

various media devices. It also does not deteriorate over time or lose quality after being

used multiple times.

 A Computer program is a collection of instructions that can be executed by a computer to

perform a specific task.

 A computer program is usually written by a computer programmer using a programming

language.
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 A bit is the short form of Binary digit which can be

‘0’ or ‘1’. It is the basic unit of data in computers.

 A nibble is a collection of 4 bits (Binary digits).

 A collection of 8 bits is called Byte.

 A byte is considered as the basic unit of measuring

the memory size in the computer.
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 A collection of 1024 bytes is called Kilo Byte (KB).

 A collection of 1024 Kilo bytes is called Mega Byte (MB).

 A collection of 1024 mega bytes is called Giga Byte (GB).

 A collection of 1024 Giga bytes is called Terra Byte (TB).

 A collection of 1024 Terra Bytes is called Peta Byte (PB).

 A collection of 1024 Peta bytes is called Exa Byte (EB).

 A collection of 1024 Exa bytes is called Zetta Byte (ZB).

 A collection of 1024 Zetta bytes is called Yotta Byte (YB).
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Types of Computers 
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 Computers can be also classified by size and power as follows, though there is considerable 

overlap: 

 Supercomputer: An extremely fast computer that can perform Billions of instructions per 

second. 

 Mainframe: A powerful multi-user computer capable of supporting many hundreds or 

thousands of users simultaneously. 

 Minicomputer: A multi-user computer capable of supporting up to hundreds of users 

simultaneously. 

 Workstation: A powerful, single-user computer. A workstation is like a personal computer, 

but it has a more powerful microprocessor and, in general, a higher-quality monitor. 

 Macro Computer: A small, single-user computer based on a microprocessor.



Super Computer
22

 A Supercomputer is a computer with a high level of performance compared to
a general-purpose computer. The performance of a supercomputer is
commonly measured in FLoating-point Operations Per Second (FLOPS) instead
of Million Instructions Per Second (MIPS). Super Computers can process billions
of instructions per second.

 Supercomputers are very expensive and are employed for specialized
applications that require immense amounts of mathematical calculations
(number crunching).

 For example, weather forecasting requires a supercomputer. Other uses of
supercomputers scientific simulations, (animated) graphics, fluid dynamic
calculations, nuclear energy research, Stock Analysis, electronic design, and
analysis of geological data (e.g. in petrochemical prospecting).
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Main Frame Computers
24

 Mainframes are a type of computer that generally are known for their large
size, amount of storage, processing power and high level of reliability.

 Nearly all mainframes can run (or host) multiple operating systems.
Mainframes are designed to handle very high-volume input and output (I/O)
and emphasize throughput computing.

 A single mainframe can replace dozens or even hundreds of smaller servers.

 Mainframe computers are primarily used by large organizations for critical
applications such as bulk data processing, census, industry and consumer
statistics, enterprise resource planning; and transaction processing.

 The chief difference between a Supercomputer and a Mainframe is that a
supercomputer channels all its power into executing a few programs as fast as
possible, whereas a mainframe uses its power to execute many programs
concurrently.
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 In some ways, mainframes are more powerful than
supercomputers because they support more simultaneous
programs. But supercomputers can execute a single program
faster than a mainframe.

 Some examples of Mainframe computers are
 1. IBM zEnterprise System.

 2. IBM System z9.

 3. IBM System z10.

 4. Fujitsu’s ICL VME.

 5. Hitachi’s Z800.



Mini Computer
26

 A minicomputer is a computer which has all the features of a large
size computer, but its size is smaller than those.

 A minicomputer lies between the mainframe and the microcomputer
because its size is smaller than the former one and larger than the
latter one.

 Minicomputers are mainly multi-users systems where more than one
user can work simultaneously.

 Also, the power of processing of minicomputers is not larger than
the power of mainframe and supercomputers. These minicomputers
can do time-sharing, batch processing, and online processing.
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 The Notable examples of Minicomputers are

 Control Data's CDC 160A and CDC 1700

 DEC PDP and VAX series

 Data General Nova

 Hewlett-Packard HP 3000 series and HP 2100 series

 Honeywell-Bull DPS 6/DPS 6000 series

 IBM midrange computers

 Interdata 7/32 and 8/32



Workstation
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 It is a type of computer used for engineering
applications (CAD/CAM), desktop publishing, software
development, and other types of applications that
require a moderate amount of computing power and
relatively high-quality graphics capabilities.

 Workstations generally come with a large, high-
resolution graphics screen, at large amount of RAM,
built-in network support, and a graphical user interface.
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 The most common operating systems for workstations

are UNIX and Windows NT.

 Like personal computers, most workstations are

single-user computers. However, workstations are

typically linked together to form a local-area

network, although they can also be used as stand-

alone systems.



Micro computers
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 Desktop computers, laptops, personal digital

assistant (PDA), tablets & smartphones are all types

of microcomputers.

 The micro-computers are widely used & the fastest

growing computers. These computers are the

cheapest among the other three types of computers.
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 The Micro-computers are specially designed for general
usage like entertainment, education and work purposes.

 Well known manufacturers of Micro-computer are Dell,
Apple, Samsung, Sony & Toshiba.

 A Microcomputer contains a microprocessor (a central
processing unit on microchip), memory in the form of
read-only memory and random-access memory, I/O
ports and a bus or system of interconnecting wires, that
is usually called as motherboard.



Programming Languages
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 Language is defined as a means of communication.

 A programming language is a formal language comprising a set of
instructions that produce various kinds of output. Programming
languages are used in computer programming to implement
algorithms.

 Programming Language provides communication between human
and the machine.

 There are three types of programming language

 Machine Language

 Assembly Language

 High Level Language
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 Machine language is the low level programming language.

 Machine language can only be represented by 0s and 1s.

 In earlier when we have to create a picture or show data on
the screen of the computer then it is very difficult to draw
using only binary digits(0s and 1s).

 For example: To write 120 in the computer system its
representation is 1111000. So it is very difficult to learn. To
overcome this problem the assembly language is invented.



34

 Assembly language is the more than low level and less

than high-level language so it is intermediary language.

 Assembly languages use numbers, symbols, and

abbreviations instead of 0s and 1s.

For example:

 For addition, subtraction and multiplications it uses

symbols likes Add, sub and Mul, etc.
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Machine Language Assembly Language

Machine language is only understood by the 

computers.

Assembly language is only understand by 

human beings not by the computers.

In machine language data only represented 

with the help of binary format(0s and 1s), 

hexadecimal and octadecimal.

In assembly language data can be 

represented with the help of mnemonics such 

as Mov, Add, Sub, End etc.

Machine language is very difficult to 

understand by the human beings.

Assembly language is easy to understand by 

the human being as compare to machine 

language.

Modifications and error fixing cannot be 

done in machine language.

Modifications and error fixing can be done 

in assembly language.
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Machine Language Assembly Language

Machine language is very difficult to 

memorize so it is not possible to learn the 

machine language.

Easy to memorize the assembly language 

because some alphabets and mnemonics 

are used.

Execution is fast in machine language 

because all data is already present in 

binary format.

Execution is slow as compared to machine 

language.

There is no need of translator.The 

machine understandable form is the 

machine language.

Assembler is used as translator to convert 

mnemonics into machine understandable 

form.

Machine language is hardware 

dependent.

Assembly language is the machine 

dependent and it is not portable.

Machine language is very difficult to 

memorize so it is not possible to learn the 

machine language.

Easy to memorize the assembly language 

because some alphabets and mnemonics 

are used.



High level Language
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 High level languages are instructions, which are called
as statements that use brief statements or arithmetic
expressions.

 High level language statements resemble the phrases or
mathematics expression required to express the problem
or procedure being programmed.

 Most common programming languages are considered
high-level languages. Examples include C++,C#, Cobol,
Java, JavaScript, PHP, Python, etc.,
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 Each of these languages use different syntax.

 Some are designed for writing desktop software programs, while
others are best-suited for web development. But they all are
considered high-level since they must be processed by a compiler
or interpreter before the code is executed.

 Source code written in languages like C++ and C# must be
compiled into machine code in order to run. The compilation process
converts the human-readble syntax of the high-level language into
low-level code for a specific processor.

 Source code written in scripting languages like Perl and PHP can be
run through an interpreter, which converts the high-level code into a
low-level language on-the-fly.



Advantages 
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1. High level languages are programmer friendly. They
are easy to write, debug and maintain.

2. It provide higher level of abstraction from machine
languages.

3. It is machine independent language.

4. Easy to learn.

5. Less error prone, easy to find and debug errors.

6. High level programming results in better programming
productivity.



Disadvantages 
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1. It takes additional translation times to translate the
source to machine code.

2. High level programs are comparatively slower than
low level programs.

3. Compared to low level programs, they are
generally less memory efficient.

4. Cannot communicate directly with the hardware.
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High Level Language Low Level Language

It is programmer friendly language. It is a machine friendly language.

High level language is less memory efficient. Low level language is high memory efficient.

It is easy to understand. It is tough to understand.

It is simple to debug. It is complex to debug comparatively.

It is simple to maintain. It is complex to maintain comparatively.

It is portable. It is non-portable.

It can run on any platform. It is machine-dependent.

It needs compiler or interpreter for translation. It needs assembler for translation.

It is used widely for programming.
It is not commonly used now-a-days in 

programming.



Language Processors
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 The language processor that reads the complete source
program written in high level language in one go and
translates it into an equivalent program in machine language
is called as a Compiler.
 Example: C, C++, C#, Java.

 In a compiler, the source code is translated to object code
successfully if it is free of errors. The compiler specifies the
errors at the end of compilation with line numbers when there
are any errors in the source code. The errors must be
removed before the compiler can successfully recompile the
source code again
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Assembler
45

 The Assembler is used to translate the program

written in Assembly language into machine code.

The source program is an input of assembler that

contains assembly language instructions. The output

generated by assembler is the object code or

machine code understandable by the computer.
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Interpreter
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 The translation of single statement of source program into machine code is
done by language processor and executes it immediately before moving
on to the next line is called an interpreter.

 If there is an error in the statement, the interpreter terminates its
translating process at that statement and displays an error message.

 The interpreter moves on to the next line for execution only after removal
of the error.

 An Interpreter directly executes instructions written in a programming or
scripting language without previously converting them to an object code or
machine code.

 Example: Perl, Python and Matlab.
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Compiler Interpreter

A compiler is a program which coverts the entire

source code of a programming language into

executable machine code for a CPU.

interpreter takes a source program and

runs it line by line, translating each line as

it comes to it.

Compiler takes large amount of time to analyze the

entire source code but the overall execution time of

the program is comparatively faster.

Interpreter takes less amount of time to

analyze the source code but the overall

execution time of the program is slower.

Compiler generates the error message only after

scanning the whole program, so debugging is

comparatively hard as the error can be present any

where in the program.

Its Debugging is easier as it continues

translating the program until the error is

met

Generates intermediate object code. No intermediate object code is generated.

Examples: C, C++, Java Examples: Python, Perl



Components of Computer System
49

 Computer System is composed of Hardware, Software,
Memory and Users.

Hardware:

❖ Hardware consists of the mechanical parts that makeup the
computer as a machine.

❖ Those devices are required for input, output, store the data
and process the data.

❖ Such devices are keyboard, Mouse, Hard disk, CD Drive,
Printer, Mother board, ROM, RAM, etc.,



Software
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 Software is a collection of data or computer instructions that
tell the computer how to work.

 Software comprises the entire set of programs, procedures,
and routines associated with the operation of a computer
system.

 A set of instructions that directs a computer's hardware to
perform a task is called a program, or software program.

 Examples of applications include Office suites, Database
programs, Web browsers, Word processors



Memory
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 Computer memory is a device that is used to store data
or programs (sequences of instructions) on a temporary
or permanent basis.

 Computer memory is divided into Main (or Primary)
memory and Auxiliary (or secondary) memory.

 Main memory holds instructions and data when a
program is executing, while auxiliary memory holds
data and programs not currently in use and provides
long-term storage.



Main Memory 
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❖ Main memory is accessible directly by the CPU.

❖ Primary memory holds only those data and instructions on
which the computer is currently working.

❖ It has a limited capacity and data is lost when power is
switched off.

❖ It is generally made up of semiconductor device.

❖ The data and instruction required to be processed resides in
the main memory.

❖ It is divided into four subcategories RAM, ROM, Cache and
Registers.
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Characteristic of Primary Memory
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❖ The computer can't run without primary memory

❖ It is known as the main memory.

❖ It is a working memory of the computer.

❖ Primary memory is faster comparing to secondary 

memory. 



Read Only Memory (ROM)
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 ROM stands for Read only Memory

 ROM is non-volatile memory.

 The user cannot write data to the ROM without special
access.

 ROM is usually found as a chip(s) on the motherboard and is
used to store the Basic Input and Output System (BIOS) of the
computer along with other important information that is
needed to function.

 ROM was designed so that the BIOS could be accessed by
the computer without the need for other parts of hardware.
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Types of ROM
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 Programmable Read Only memory (PROM)

 Erasable Programmable Read Only memory 

(EPROM).

 Electrically Erasable Programmable Read Only 

memory (EEPROM).



Programmable Read Only memory (PROM)
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 PROM or Programmable ROM (Programmable Read-Only
Memory) is a read-only memory that can be modified only once by
a user.

 The user buys a blank PROM and enters the desired contents using
a PROM program.

 Inside the PROM chip, there are small fuses which are burnt open
during programming.

 PROM was first developed by Wen Tsing Chow in 1956.

 An example of a PROM is a computer BIOS in early computers.

 Today, PROM in computers has been replaced by EEPROM.
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EPROM.
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 EPROM (Erasable programmable read-only memory) that
can be erased and re-used. Erasure is caused by shining an
intense ultraviolet light through a window that is designed
into the memory chip.

 This type of memory you can rewrite data over the old data,
but you cannot keep the old data.

 So once you burn the new data into the ROM chip, the old
data is gone.

 EPROM ensures each process will be performed repeatedly
and is more expensive then PROM, the advantages over
PROM is that is capable of multiple updates.
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EEPROM
62

 EEPROM -Electrically Erasable Programmable ROM.

 It can be erased and reprogrammed about ten thousand
times.

 Both erasing and programming take about 4 to 10 ms
(millisecond).

 In EEPROM, any location can be selectively erased and
programmed.

 EEPROMs can be erased one byte at a time, rather than
erasing the entire chip. Hence, the process of reprogramming
is flexible but slow.
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Cache Memory
64

 CACHE is a hardware or software component that stores data so that
future requests for that data can be served faster; the data stored in a
cache might be the result of an earlier computation or a copy of data
stored elsewhere.

 Cache is used to store small bits of frequently accessed data from the RAM
so that the processor doesn't have to wait for the RAM to respond every
time it wants the same piece of information.

 Cache is volatile, like RAM, so it wipes clear whenever the computer gets
turned off.

• Cache memory lies on the path between the CPU and the main memory.

• It facilitates the transfer of data between the processor and the main 
memory at the speed which matches to the speed of the processor.
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 Processor registers are located inside the processor. 

 Each register typically holds a word of data (often 32 
or 64 bits). 

 CPU instructions instruct the arithmetic logic unit to 
perform various calculations or other operations on this 
data (or with the help of it). 

 Registers are the fastest of all forms of computer data 
storage.



Random Access Memory (RAM)
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 RAM is a type of data storage used in computers, it acts
as a mediator between the CPU and the storage device
which helps speed up the computer.

 When the user try to access a piece of information, such
as opening an application, it gets moved from the hard
drive to the RAM.

 The CPU then reads from the RAM instead of the hard
drive as it can access the RAM and read from it much
faster than it can if the data was still on the hard drive.
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 RAM is of two types −
❖ Static RAM (SRAM)

❖ Dynamic RAM (DRAM)

 The word static indicates that the memory retains its contents as
long as power is being supplied. However, data is lost when the
power gets down due to volatile nature.

 DRAM must be continually refreshed in order to maintain the data.
This is done by placing the memory on a refresh circuit that rewrites
the data several hundred times per second. DRAM is used for most
system memory as it is cheap and small.



Differences Between RAM and ROM
69

1. RAM is a temporary storage type of memory as data lasts
only till the time the power supply is on. On the contrary,
ROM is a permanent memory that retains the data for a
longer duration.

2. Random-access memory is volatile in nature. But read-only
memory is non-volatile in nature.

3. The operating speed of RAM is faster than the ROM.

4. RAM offers memory capacity in GB usually 1 to 256 GB per
chip. On the contrary, ROM permits the storage capacity in
MB, usually in the range 4 to 8 MB per chip.
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5. RAM stores data on transistors thus requires a continuous source of
power. While data stored in ROM remain unaffected with power failure.

6. The data stored in RAM is changeable by the user. Whereas the data in
ROM cannot be altered by the user.

7. RAM offers the user to read as well as write data but data in ROM is
pre-written and thus can only be read by the user.

8. The processor can directly access the data present in RAM. However, the
data present in ROM do not permit direct access to the processor.

9. The cost of Random access memory is comparatively higher than the
read-only memory.



RAM
71



Secondary Memory
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 This type of memory is also known as external memory or
non-volatile.

 It is slower than the main memory.

 These are used for storing data/information permanently.

 CPU directly does not access these memories, instead they
are accessed via input-output routines.

 The contents of secondary memories are first transferred to
the main memory, and then the CPU can access it.

 For example, disk, CD-ROM, DVD, etc.



Characteristics of Secondary Memory
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❖ These are magnetic and optical memories.

❖ It is known as the backup memory.

❖ It is a non-volatile memory.

❖ Data is permanently stored even if power is switched
off.

❖ It is used for storage of data in a computer.

❖ Computer may run without the secondary memory.

❖ Slower than primary memories.



Magnetic Tape
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 In magnetic tape only one side of the ribbon is used for
storing data.

 It is sequential memory which contains thin plastic ribbon
to store data and coated by magnetic oxide.

 Data read/write speed is slower because of sequential
access. It is highly reliable which requires magnetic tape
drive writing and reading data.

 The width of the ribbon varies from 4mm to 1 Inch.
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Advantages
76

1. These are inexpensive, i.e., low cost memories.

2. It provides backup or archival storage.

3. It can be used for large files.

4. It can be used for copying from disk files.

5. It is a reusable memory.

6. It is compact and easy to store on racks.



Disadvantages
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1. Sequential access is the disadvantage, means it does

not allow access randomly or directly.

2. It requires caring to store, i.e., vulnerable humidity,

dust free, and suitable environment.

3. It stored data cannot be easily updated or

modified, i.e., difficult to make updates on data.



Hard Disk
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 •The Hard disk drive is the main and usually largest data
storage device in a computer.

 It is located inside the system case (cabinet).

 •It can store anywhere from 250 gigabytes to 2 terabytes.

 •Hard disk speed is the speed at which content can be read
and written on a hard disk.

 •A hard disk unit comes with a set rotation speed varying
from 4500 to 7200rpm.

 •Disk access time is measured in milliseconds.
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Floppy Disk
80

 The floppy disk (or a 3 1/2) is a removable Magnetic
Storage Medium.

 Floppy disks are used for moving information between
computers, laptops or other devices.

 Floppy disks are inserted into a floppy disk drive which
allows data to be read or stored.

 Floppy disks store much less data than a CD-ROM disk
or USB flash drive.
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 A normal 3½ inch disk can store 1.44 megabytes of data.
This is usually enough for simple text documents.

 A special type of floppy disk was made in the late 1980s. It
could store 2.88 MB of data.

 Floppy disk technology has been around since the early
1970s (the 8-inch floppy was the first).

 Today, floppy disks have been replaced by other storage
media, like USB flash drives.

 Floppy disks and drives are no longer manufactured.
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Compact Disk (CD):
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 It stores data and it has circular plastic; single side of
the plastic is coated by aluminum alloy which stores
data. It is protected by additional thin plastic covering.
CD requires a CD drive for its operation.

 CDs can hold up to 700 MB worth of data, which is
about 80 minutes of music.

 CD's can be Classified as CD-R, CD-RW,CD-Audio,
Video CD or VCD and DVD.



USB
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 A USB flash drive (USB stands for Universal Serial Bus) is a
popular way to store digital information.

 Flash drives are an easy way to share data (information).

 A USB flash drive can be attached to a USB port, and
provides a certain amount of storage space, which can be
used to store data.

 They are called "flash drive" because they use flash memory
to store files. Flash memory is a type of computer chip.
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 USB flash drives have some advantages over other portable
storage devices.

 They are physically much smaller and more rugged than
floppy disks. They can read data faster and store more data
than floppy disks.

 Flash drives are used to store any type of data file, or to
move data from one computer to another.

 USB flash drives have a lot of storage space. It is often
easier to use a flash drive than to carry many CD-ROMs.
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 Some computer programs can be run from a USB flash drive.
These special versions of programs are called "portable"
versions.

 Computer administrators, or people who manage the
computer systems, sometimes use flash drives.

 Sometimes flash drives are also used to run a computer virus
scanner. They are often used to repair a computer system
that was damaged or faulty.

 Most computers today can boot from a USB drive. Special
operating systems can run from a bootable flash drive.



DVD
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 A DVD (which means Digital Versatile Disc or a
Digital Video Disc) is an optical disc capable of
storing up to 4.7 GB of data, more than six times
what a CD can hold.

 DVDs are often used to store movies at better
quality than a VHS.

 Like CDs, DVDs are read with a laser.
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 The disc can have one or two sides, and one or two layers of 
data per side; the number of sides and layers determines 
how much it can hold. A 12 cm diameter disc may have one 
of the following storage capacities:
 DVD-5: single sided, single layer, 4.7 gigabytes (GB)

 DVD-9: single sided, double layer, 8.5 GB .

 DVD-10: double sided, single layer on both sides, 9.4 GB DVD-
14: double sided, double layer on one side, single layer on other, 
13.3 GB)

 DVD-18: double sided, double layer on both sides, 17.1 GB



Blue Ray Disc
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 Blu-ray Disc is a high-density optical disc format similar to DVD.

 A dual-layer Blu-ray disc can store up to 50GB (gigabytes) of
data. This is over five times the capacity of a DVD, and over 70
times more than a CD or VCD.

 The disc was developed by the Blu-ray Disc Association (BDA) and
released in 2006. The format was developed for recording,
rewriting and playback of high-definition video (HD), as well as
storing large amounts of data.

 Older optical disc technologies such as DVD, DVD±R, DVD±RW,
and DVD-RAM used a red laser to read and write data. The new
format used a blue-violet laser instead.
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History of Computers
92

 The first generation of the computer used vacuum tubes for the circuitry

and the magnetic drums for the memory and taking up the big rooms.

 A vacuum tube was a fragile glass device, which filaments as a source

of electronics and could control and amplify electronic signals.

 It was the only high – speed electronic switching devices available in

those days.



First Generation: Vacuum Tubes (1940–1956)
93

 The first-generation computers were very expensive to
operate and uses a great amount of electricity and
produced a large amount of heat.

 The first generation of the computer relied on the
machine language. It can solve the one problem at a
time can’t do the multitasking work. The input was based
on the punched cards and the paper tape and the
output was displayed on the printouts.
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 Advantages

 Vacuum tubes were the only electronic component available during those days.

 Vacuum tube technology made possible to make electronic digital computers.

 Disadvantages

 The computers were very large in size.

 They consumed a large amount of energy.

 They heated very soon due to thousands of vacuum tubes.

 They were not very reliable.

 Air conditioning was required.
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 Constant maintenance was required.

 Non-portable.

 Costly commercial production.

 Limited commercial use.

 Very slow speed.

 Limited programming capabilities.

 Used machine language only.

 Used magnetic drums which provide very less data storage.

 Used punch cards for input.



Vacuum Tubes
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Second Generation (1956-1964)
97

 John Bardeen, William Shockley, and Walter Brattain
invented a new electronic switching device called
transistors at Bell laboratories in 1947.

 Transistors were used in the second generation of the
computer and transistors replaced the vacuum tubes.

 Due to the transistor’s computer becomes smaller,
cheaper and faster. It is very reliable than the first
generation of the computer.
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 Transistors were also produced the large amount of heat
that subjected the computer to damage. But some
improvement was shown that in the second generation of
the computer.

 High-level programming languages were also
developed at the same time. The first computer of the
second generation was developed for the atomic
energy industry.



Advantages
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✓ More reliable than the first generation.

✓ Good speed and can calculate the data in the 
microseconds.

✓ Also used assembly languages.

✓ Smaller in the size as compared to the first generation.

✓ Use less amount of energy.

✓ Portable

✓ Accuracy is improved than its predecessor.



Disadvantages
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✓ Constant maintenance is required to work properly.

✓ Commercial production was very difficult.

✓ Still punched cards were used for input.

✓ The cooling system is required.

✓ More expensive and non-versatile.

✓ Used for specific purposes.



Transistors
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Third Generation Computers (1965-1970)
102

 Third generation of computers are Integrated Circuits (IC)
which was founded by Jack St. Clair Kilby and Robert Noyce
in 1958.

 Integrated circuits are the circuits consisting of several
electronic components like transistors, capacitors, and
resistors.

 Transistors were placed on the silicon chips known as
semiconductors which increases the speed and efficiency of
the computer drastically.
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 A single IC chip may contain thousands of transistors.

 Instead of the punched cards and printouts, users
interacted with third generation computers through
keyboards and monitors and interfaced with an OS
(operating system), which allowed the device to run
many applications at one time.

 This generation of the computer is small, cheaper and
reliable than its predecessors.
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 Another salient feature of these computers was that they
were much more reliable and consumed far less power.

 The input languages for such computers were COBOL,
FORTRAN-II up to FORTRAN-IV, PASCAL, ALGOL-68,
BASIC, etc. These languages were much better and
could represent more information.

 Consequently, more and more complex calculations are
possible.



Advantages
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✓ Smaller in size as compared to previous generations.

✓ More reliable.

✓ Used less energy

✓ Produced less heat as compared to the previous two 

generations of computers.

✓ Better speed and could calculate data in nanoseconds.
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✓ Used fan for heat discharge to prevent damage.

✓ Maintenance cost was low because hardware failure is rare.

✓ Could be used for high-level languages.

✓ Versatile to an extent

✓ Less expensive

✓ Better accuracy

✓ Commercial production increased.

✓ Used mouse and keyboard for input.



Disadvantages
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✓ Air conditioning was required.

✓ Highly sophisticated technology required for the 

manufacturing of IC chips



Integrated Circuits
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Fourth Generation Computers (1975-Present)
109

 The fourth-generation computers started with the invention of
Microprocessor.

 The Microprocessor contains thousands of ICs.

 Ted Hoff produced the first microprocessor in 1971 for Intel. It was
known as Intel 4004.

 It greatly reduced the size of computer.

 The size of modern Microprocessors is usually one square inch.

 During the fourth generation, semiconductors memories replaced
magnetic core memories resulting in large random-access memories
with very fast access time.
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 On another side, Hard disks became cheaper, smaller, and
larger in capacity.

 On the software side, several new developments came to
match the new technologies of the fourth generation.

 This generation of computers had the first “supercomputers”
that could perform many calculations accurately.

 The computer languages like languages like C, C+, C++,
DBASE etc. were the input for these computers.
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 Advantages

 More powerful and reliable than previous generations.

 Smaller in size

 Fast processing power with less power consumption

 Fan for heat discharging and thus to keep cold.

 No air conditioning required.

 Cheapest among all generations

 All types of High-level languages can be used in this type of computers

 Disadvantages

 The latest technology is required for manufacturing of Microprocessors.



Micro Processor
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Input Devices

 Any device that allows information from outside the computer
to be communicated to the computer is considered as an
Input Device.

 These include a Keyboard, Mouse, Trackball, Spaceball,
Joystick, Light Pens, Barcode readers, Image Scanners,
Touch Panels and Magnetic Ink Character Recognition
(MICR).

 Analog- Mouse, Trackball, Scanner, Joystick.

 Digital- Keyboard, Light pen, Touch panels.



Keyboards
 Keyboard is used to enter the data into a computer.

 Generally 108 keys are in keyboard.

 It consists of Alphanumeric keys, function keys , Cursor control keys and Control
Keys.

 Alphanumeric Keys include (A-Z),(0-9),(`~!@#$%^&*()_-+={}:”;<>?,./)

 Cursor-control keys and function keys are common features on general purpose
keyboards.

 Function keys (F1 to F12) allow users to enter frequently used operations in a
single keystroke, and cursor-control keys can be used to select displayed
objects or coordinate positions by positioning the screen cursor.

 Special Keys include Enter Key, Backspace, Number Lock, Caps Lock, Ctrl, Shift.





Mouse

 A mouse is small hand-held box used to position the screen
cursor.

 Wheels or rollers on the bottom of the mouse can be used to
record the amount and direction of movement.

 Another method for detecting mouse motion is with an optical
sensor. For these systems, the mouse is moved over a special
mouse pad that has a grid of horizontal and vertical lines.

 The optical sensor detects movement across the lines in the
grid.



 There are three types of mouse.

 Mechanical mouse: Houses a hard rubber ball that rolls as the mouse is
moved. Sensors inside the mouse body detect the movement and translate
it into information that the computer interprets.

 Optical mouse: Uses an LED sensor to detect tabletop movement and then
sends off that information to the computer for merry munching.

 Infrared (IR) or radio frequency cordless mouse: With both these types,
the mouse relays a signal to a base station wired to the computer’s mouse
port. The cordless mouse requires power, which comes in the form of
batteries.







Trackball 

 A trackball is a computer pointing device which can perform
the same functions as a mouse.

 With a trackball, The user rolls the ball to direct the cursor to
the desired place on the screen and can click one of two
buttons (identical to mouse buttons) near the trackball to
select desktop objects or position the cursor for text entry.

 A trackball spins very freely, so a simple flick of your fingers
will produce a scroll much longer than a movement with a
mouse.







Spaceball

 A graphical input device that is based on a fixed spherical ball. It allows complex
objects to be positioned and rotated in three-dimensional space using the single
input device.

 While a trackball is a two-dimensional positioning device, whereas a Spaceballs
provides six degrees of freedom.

 Unlike the trackball, a Spaceballs does not actually move.

 Strain gauges measure the amount of pressure applied to the spaceballs to provide
input for spatial positioning and orientation as the ball is pushed or pulled in various
directions.

 Spaceballs are used for three-dimensional positioning and selection operations in
virtual-reality systems, modeling, animation, CAD, and other applications.







Joystick

 A joystick consists of a small, vertical lever (called the stick) mounted on a base that
is used to steer the screen cursor around.

 Most joysticks select screen positions with actual stick movement; others respond to
pressure on the stick.

 Some joysticks are mounted on a keyboard; others function as stand-alone units.

 The distance that the stick is moved in any direction from its center position
corresponds to screen-cursor movement in that direction.

 Potentiometers mounted at the base of the joystick measure the amount of
movement, and springs return the stick to the center position when it is released.

 One or more buttons can be programmed to act as input switches to signal certain
actions once a screen position has been selected.







Light Pen

 A light pen is a computer input device in the form of a light-sensitive wand
used in conjunction with a computer's cathode-ray tube (CRT) display.

 It allows the user to point to displayed objects or draw on the screen in a
similar way to a touchscreen but with greater positional accuracy.

 A light pen can work with any CRT-based display, but its ability to be used
with LCDs.

 A light pen may also be used to describe the pen (stylus) used with a
graphics tablet.

 Today, light pens are no longer used due to the invention of touch screens.



Light pen





Touch Panels

 Touch panels allow displayed objects or screen positions to be selected with the
touch of a finger.

 A typical application of touch panels is for the selection of processing options that
are represented with graphical icons.

 Some systems can be adapted for touch input by fitting a transparent device with a
touch sensing mechanism over the video monitor screen.

 Touch input can be recorded using optical, electrical, or acoustical methods.

 Optical touch panels employ a line of infrared light-emitting diodes (LEDs) along
one vertical edge and along one horizontal edge of the frame.

 The opposite vertical and horizontal edges contain light detectors. These detectors
are used to record which beams are interrupted when the panel is touched.





Image Scanners

 A Scanner is a device that optically scans Images, Printed Text,
Handwriting or An Object and converts it to a digital image.

 Generally in the Flatbed scanners, the document is placed on a
Glass Window for scanning.

 Drawings, Graphs, Color and Black-and-white photos, or Text can
be stored for computer processing with an Image Scanner by
passing an optical scanning mechanism over the information to be
stored.

 Finally, it stores the image information in a specific file format such
as JPEG, GIF, TIFF, BMP, PDF documents and so on.



Types of Scanner

 Flat bed Scanners- also called as Desktop Scanners, are the most
versatile and commonly used scanners.

 Sheet bed Scanners- are similar to the flatbed scanners except the
document is moved and the scan head is immoveable. A sheet bed
scanner looks a lot like a small portable printer.

 Hand held Scanners- uses the same basic technology as a flatbed
scanner, but rely on the user to move them instead of a motorized
belt. This type of scanner typically does not provide good image
quality. However, it can be useful for capturing an image quickly.



 Drum Scanners- are used by the publishing industry to
capture incredibly detailed images.

 They use a technology called Photo Multiplier Tube (PMT).

 In PMT, the document to be scanned is mounted on a glass
cylinder. Located at the center of the cylinder is a sensor that
splits light bounced from the document into three beams.

 Each beam is sent through a colour filter into a photo
multiplier tube where the light is changed into electrical
signal.



Flat bed Scanner



Sheet fed Scanner



Hand held Scanner



Drum Scanner



Magnetic Ink Character Recognition (MICR)

 Magnetic ink character recognition code, known in short as MICR code, is
a character recognition technology used mainly by the banking industry to
streamline the processing and clearance of cheques and other documents.

 MICR encoding, called the MICR line, is at the bottom of cheques and other
vouchers and typically includes the document-type indicator, bank code,
bank account number, cheque number, cheque amount (usually added after
a cheque is presented for payment), and a control indicator.

 The MICR read head is a device built into the scanner designed to read
the magnetic signal emitted by the MICR ink characters on the check. Each
character produces a unique waveform which is read and translated by the
MICR read head.







Optical Mark Recognition(OMR)

 Optical mark recognition (also called optical mark
reading and OMR) is the process of capturing human-
marked data from document forms such as surveys and
tests.

 They are used to read questionnaires, multiple choice
examination paper in the form of lines or shaded areas.

 Optical Mark Readers reads pencil or pen marks made
in pre-defined positions on paper forms as responses to
questions or tick list prompts.





Optical Character Recognition

 Optical character recognition or optical character

reader (OCR) is the electronic or mechanical

conversion of images of typed, handwritten or

printed text into machine-encoded text, whether

from a scanned document, a photo of a document, a

scene-photo (for example the text on signs and

billboards in a landscape photo)





HARD COPY DEVICES



Hard copy devices

 The computer processes input data to produce useful
information.

 This information can be displayed or viewed on a monitor,
printed on a printer or listened through speakers or headset
or it can be stored in the secondary memory device for
further processing or future reference.

 The different ways of output can be broadly classified as
✓ Hard copy

✓ Soft copy.



 Soft Copy: The electronic version of an output, which usually resides in
computer memory and/or on disk is known as Soft Copy. Soft copy
output also includes audio and visual form of output generated using
computer.

 Hard Copy: Hard-copy devices are the entities that produce the
output which can be retained over the time. That is, nothing but
printing over the paper.

 Hard- copy devices can be classified into two categories; one is the
Printers and second is the Plotters.

 The quality of the pictures obtained from a device depends on dot
size and the number of dots per inch, or Lines per inch, that can be
displayed.

 To produce smooth characters in printed text strings, higher -quality
printers shift dot positions so that adjacent dots overlap.



Monitors

 A computer monitor is an output device that displays information in
pictorial form.

 The monitor displays the computer's user interface and open programs,
allowing the user to interact with the computer, typically using the
keyboard and mouse.

 The size of the computer screen is measured diagonally from corner to
corner in inches.

 For desktop computers, common sizes are 13,15,17,19 and 21 inches.

 For laptop computers, 12.1,13.3,14.1 inches.

 There are two types of monitors: 1) Cathode Ray Tubes, 2) Liquid Crystal
Display.



Printers 

 Printer is an output device, which is used to print information
on paper.

 There are two types of printers −
 Impact Printers

 Non-Impact Printers

 Impact printers print the characters by striking them on the
ribbon, which is then pressed on the paper.

 Non-impact printers print the characters without using the
ribbon. These printers print a complete page at a time,



Impact printers

 Characteristics of Impact Printers are the following −

 Very low consumable costs.

 Very noisy

 Useful for bulk printing due to low cost

 There is physical contact with the paper to produce an image

 These printers are of two types −

 Character printers

 Line printers



Character Printers

 Character printers are the printers which print one character at a 
time.

 Dot Matrix Printer

 Dot matrix has printed in the form of dots. A printer has a head
which contains nine pins. The nine pins are arranged one below
other. Each pin can be activated independently. All or only the
same needles are activated at a time. When needless is not
activated, and then the tip of needle stay in the head. When pin
work, it comes out of the print head. In nine pin printer, pins are
arranged in 5 * 7 matrixes.



 Advantages

 Inexpensive

 Widely Used

 Other language characters can be printed

 Disadvantages

 Slow Speed

 Poor Quality







Line Printers

 Line Printers are the printers which print one line at a time.

 These are of two types −
 Drum Printer

 Chain Printer

 Drum Printer

 This printer is like a drum in shape hence it is called drum printer.

 The surface of the drum is divided into several tracks.

 Total tracks are equal to the size of the paper, i.e. for a paper
width of 132 characters, drum will have 132 tracks.



 A character set is embossed on the track. Different character sets available
in the market are 48-character set, 64 and 96 characters set.

 One rotation of drum prints one line.

 Drum printers are fast in speed and can print 300 to 2000 lines per
minute.

 Advantages

 Very high speed

 Disadvantages

 Very expensive

 Characters fonts cannot be changed



Chain Printer

 In this printer, a chain of character sets is used, hence it is 
called Chain Printer. A standard character set may have 48, 
64, or 96 characters.

 Advantages
 Character fonts can easily be changed.

 Different languages can be used with the same printer.

 Disadvantages
 Noisy



Cylinder of  Drum Printer



Drum Printers



Chain Printers



Line Printers



Non-impact Printers

 Non-impact printers print the characters without using the ribbon. These
printers print a complete page at a time; thus they are also called as Page
Printers.

 These printers are of two types −
 Laser Printers

 Inkjet Printers

 Characteristics of Non-impact Printers

 Faster than impact printers

 They are not noisy

 High quality

 Supports many fonts and different character size



Laser Printers

 They use laser lights to produce the dots needed to form the characters to
be printed on a page.

 Advantages

 Very high speed

 Very high-quality output

 Good graphics quality

 Supports many fonts and different character size

 Disadvantages

 Expensive

 Cannot be used to produce multiple copies of a document in a single printing







Colour Laser Printer

 A colour laser printer works like a single laser printer,
except that the process is repeated four times with four
different ink colours: Cyan, magenta, yellow and black.

 Laser printers have high resolution from 600 dots per
inch upto 1200 per inch.

 These printers print 4 to 16 page of text per minute.

 The high quality and speed of laser printers make them
ideal for office environment.



Inkjet Printers
 Inkjet printers are non-impact character printers based on a relatively new

technology. They print characters by spraying small drops of ink onto paper.
Inkjet printers produce high quality output with presentable features.

 They make less noise because no hammering is done, and these have many
styles of printing modes available. Color printing is also possible. Some models
of Inkjet printers can produce multiple copies of printing also.

 Advantages

 High quality printing

 More reliable

 Disadvantages

 Expensive as the cost per page is high

 Slow as compared to laser printer



Ink jet Printers



Plotters

 Plotters are a special type of output device. It is suitable for 
applications:

 Architectural plan of the building.

 CAD applications like the design of mechanical components of aircraft.

 Many engineering applications.

Advantage:

 It can produce high-quality output on large sheets.

 It is used to provide the high precision drawing.

 It can produce graphics of various sizes.

 The speed of producing output is high.



 Drum Plotter:

 It consists of a drum. Paper on which design is made is kept on the drum. The drum
can rotate in both directions. Plotters comprised of one or more pen and penholders.
The holders are mounted perpendicular to drum surface. The pens are kept in the
holder, which can move left to the right as well as right to the left. The graph plotting
program controls the movement of pen and drum.

 Flatbed Plotter:

 It is used to draw complex design and graphs, charts. The Flatbed plotter can be
kept over the table. The plotter consists of pen and holder. The pen can draw
characters of various sizes. There can be one or more pens and pen holding
mechanism. Each pen has ink of different color. Different colors help to produce
multicolor design of document. The area of plotting is also variable. It can vary A4
to 21'*52'.
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 Word Processing is the manipulation of character set, word, text, numbers,
sentences, and paragraphs in the document so that it is error free and
looks attractive.

 The work of preparing and formatting document was done manually with
the help of typewriter.

 A word processor is an application software for word processing, with a
word processing program, you can create letters, tables, newsletters, and
academic papers that are easy to revise.

 Word processor is a software package that enables you to create, edit,
print and save documents for future retrieval and reference.

 Word processors can create multiple types of files, including text files (.txt),
rich text files (.rtf), HTML files (.htm & .html), and Word files (.doc & .docx).
Some word processors can also be used to create XML files (.xml).



Word processing Softwares
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 Abiword (Free).

 Apple iWork.

 Corel WordPerfect.

 Google Docs (online and free).

 LibreOffice -> Writer (free).

 Microsoft Office -> Microsoft Word.

 Apache OpenOffice (free).

 Sun StarOffice (Free)

 LibreOffice Writer (Free)



Benefits of Word Processor
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 Book - Write a book.

 Document - Any text document that requires formatting.

 Help documentation - Support documentation for a product or service.

 Journal - Keep a digital version of your daily, weekly, or monthly journal.

 Letter - Write a letter to one or more people. Mail merge could also be used to
automatically fill in the name, address, and other fields of the letter.

 Marketing plan - An overview of a plan to help market a new product or service.

 Memo - Create a memo for employees.

 Report - A status report or book report.

 Résumé - Create or maintain your résumé.

 Calendars- Yearly calendar of various types.



Features of word processing
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Text formatting - Changing the font, font size, font color, bold, italicizing,
underline, etc.

Copying, cutting, and pasting - Once text is entered into a document, it can
be copied or cut and pasted in the current document or another document.

Multimedia - Insert clip art, charts, images, pictures, and video into a
document.

Spelling and Grammar - Checks for spelling and grammar errors in a
document.

Adjust the layout - Capable of modifying the margins, size, and layout of a
document.

Find - Word processors give you the ability to quickly find any word or text in
any size of the document.
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 Search and Replace - You can use the Search and Replace feature to
replace any text throughout a document.

 Indentation and lists - Set and format tabs, bullet lists, and number lists.

 Insert tables - Add tables to a document.

 Word wrap - Word processors can detect the edges of a page or
container and automatically wrap the text using word wrap.

 Header and footer - Being able to adjust and change text in the header
and footer of a document.

 Thesaurus - Look up alternatives to a word without leaving the program.

 Multiple windows - While working on a document, you can have
additional windows with other documents for comparison or move text
between documents.
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 AutoCorrect - Automatically correct common errors (e.g., typing "teh" and having it 
autocorrected to "the").

 Mailers and labels - Create mailers or print labels.

 Import data - Import and format data from CSV, database, or another source.

 Headers and footers - The headers and footers of a document can be customized to 
contain page numbers, dates, footnotes, or text for all pages or specific pages of 
the document.

 Merge - Word processors allow data from other documents and files to be 
automatically merged into a new document. For example, you can mail merge names 
into a letter.

 Macros - Setup macros to perform common tasks.

 Collaboration - More modern word processors help multiple people work on the 
same document at the same time.



MS Word
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 Microsoft word is one of the most popular word processing
programs supported by both Mac and PC platforms.

 Microsoft word is used to create documents, brochures,
leaflets, outlines, resumes, lists and simple web pages.

 To begin Microsoft Word, goto Start→ Programs→Microsoft
Office → Microsoft Word. (or)

 Select Windows Key + R to obtain Run Command, there type
Winword and click Ok to start Microsoft Word.
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Title Bar
Menu Bar

Ruler
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Bullets and Numbering
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 UG Courses

 BA English

• BA Tamil

o B.sc Physics

▪ B.sc Chemistry

❖ B.sc Biology

➢ B.sc Micro

✓ B. Com 

 BCA

 Bsc CS

PG Courses

1) MA English

2) MA Tamil

3) M. Com

4) MCA
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Find
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Replace 
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Goto
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Insert Menu
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Design Menu 
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Layout
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Mailings
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Inserting Tables

 Tables organize text into rows and columns, which can make the text
easy to type, edit, and format while spacing it correctly in your
document. Tables organize text into cells, where a cell is the
intersection of a row and a column.

 Word provides four ways to create a table:

 Click the Insert tab, click the Table icon, and then highlight the number of 
rows and columns for your table (up to a maximum of eight rows and ten 
columns).

 Use the Insert Table dialog box.

 Draw the size and position of the table with the mouse.

 Convert existing text (divided by a delimiter character such as a tab or a 
comma).
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Creating a table by highlighting rows and columns
200

 Creating a table by highlighting rows and columns can
be fast, but it limits the size of your table to a maximum
of eight rows and ten columns. To create a table by
highlighting rows and columns, follow these steps:

1. Click the Insert tab.

2. Move the cursor where you want to insert a table in your
document.

3. Click the Table icon. A pull-down menu appears.

4. Move the mouse pointer to highlight the number of rows
and columns you want to create for your table.

5. When you highlight rows and columns, Word displays
your table directly in your document so you can see
exactly what your table will look like.

6. Click the left mouse button when you’re happy with the
size of your table.



Insert Table dialog box

 To create a table by defining a specific number of
rows and columns (up to a maximum of 63 columns),
follow these steps:

1. Click the Insert tab.

2. Move the cursor where you want to insert a table.

3. Click the Table icon. A pull-down menu appears.

4. Click Insert Table. The Insert Table dialog box
appears.

5. Click in the Number of Columns text box and type a
number between 1 and 63, or click the up or down
arrow to define the number of columns.

6. Click in the Number of Rows text box and type a
number or click the up or down arrow to define the
number of rows.
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In the AutoFit Behavior group, select one of the following radio

buttons:

 Fixed Column Width: Defines a fixed size for the column widths,

such as 0.3 inches

 AutoFit to Contents: Defines the width of a column based on the

width of the largest item stored in that column

 AutoFit to Window: Expands (or shrinks) the table to fit within the

current size of the document window

Click OK. Word draws the table in your document.

202



Drawing a Table

 Drawing a table can be especially useful
when you want to place a table in the
middle of a page and create rows and
columns of different sizes.

 To draw a table in your Word document,
follow these steps:
1. Click the Insert tab.

2. Click the Table icon. A pull-down menu appears.

3. Click Draw Table. The mouse pointer turns into a
Pencil icon.
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 Move the mouse pointer where you want to draw your table, hold down the left

mouse button, and drag the mouse to draw your table.

 Word draws a rectangular dotted box to show where your table will appear.

 Release the left mouse button when you’re happy with the size and position of your

table.

 Draw the boundaries for your table’s rows and columns:

 To draw vertical lines in your table, move the mouse pointer to the top or bottom

of the table, hold down the left mouse button, and drag the mouse up and down.

 To draw horizontal lines in your table, move the mouse pointer to the left or right

side of the table, hold down the left mouse button, and drag the mouse right and

left to draw.
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 Press Esc or double-click to turn the mouse pointer from a Pencil

icon back to an I-beam pointer.

 If you need to draw new lines on a table later, click anywhere

inside that table, and the Table Tools Layout tab appears. Then

click the Draw Table icon to turn the mouse pointer into a Pencil

icon. Now you can draw new lines in your table.



Table in Word from existing text
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 If you have existing text that you’d like to turn into a table,
you need to first separate it into chunks so Word knows how
to place the text in individual cells in a table. To separate
text, you need to use a unique character such as
 Return (paragraph mark)

 Tab

 Comma.

 Other characters, such as the # or @ characters

 By using the same unique character to divide text, you can
define how you want Word to define how much text to
display in each individual cell of a table.
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 To convert existing text into a table, follow these steps:

1. Click the Insert tab.

2. Select the text that you want to convert into a table.

3. Click the Table icon. A pull-down menu appears.

4. Click the Convert Text to Table command. The Convert Text to
Table dialog box appears

5. Select a radio button in the Separate Text At group. Choose the
option that corresponds to the way you divided your text. So if you
divided your text by tabs, you would select the Tabs radio button.

6. Click OK. Word converts your text into a table.
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Formatting and Coloring a Table

 After you create a table, you
can format individual cells
(spaces formed by the
intersection of a row and a
column) — or entire rows and
columns — by aligning text in
cells, resizing columns and
rows, and adding borders,
shading, or colors. All these
changes can make the text
inside the cells easier to read.
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Selecting all or part of a table

 Selecting all or part of a table in Word 2019

 To format and color a table, you must first select the table, row, column, or cell that

you want to modify. To select all or part of a table, follow these steps:

 Click in the table, row, column, or cell you want to modify. The Table Tools tab

appears.

 Click the Layout tab under the Table Tools heading.

 In the Table group, click Select. A pull-down menu appears.

 Choose an option, such as Select Row or Select Column. Word highlights your

chosen item in the table. At this point, you can choose a command to modify the

selected row or column (as when you choose a color or alignment).
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Aligning text in a Word table cell

 You can align text in a table cell in nine ways: top left (the default
alignment), top center, top right, center left, center, center right,
bottom left, bottom center, and bottom right.

 To align one or more cells, follow these steps:

 Click in the cell (or select multiple cells) that contains text you want to
align. The Table Tools tab appears.

 Click the Layout tab under the Table Tools heading.

 In the Alignment group, click an alignment icon such as Top Right or
Bottom Center.

 Word aligns your text. If you change the alignment of blank cells,
any new text you type in those blank cells will appear according to
the alignment you choose.
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Choosing a table style
213

 By coloring rows or columns and adding borders, you can customize the
appearance of your tables. However, it can be much faster to use a
predesigned table style instead, which can automatically format your text,
color rows, and add borders to your tables.

 To choose a table style, follow these steps:

 Move the cursor inside the table you want to modify.

 Click the Design tab under the Table Tools tab.

 In the Table Style Options group, select or clear check boxes, such as the Header
Row or Last Column check box.

 In the Table Styles group, click the More button. A pull-down menu of styles
appears. As you move the mouse pointer over a table style, Word displays a live
preview of your table formatted in the selected style.

 Click a table style. Word formats your table according to the style you chose.
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Resizing columns and rows
215

 You may need to resize a column or row in your table to expand or
shrink it so your text doesn’t appear crowded or surrounded by
empty space. You can resize a column or row by using the mouse or
by defining row heights and column widths.

 To resize a row or column with the mouse, follow these steps:

 Click anywhere inside the table you want to adjust, then move the
mouse pointer over the row or column border that you want to resize.
The mouse pointer turns into a two-way pointing arrow.

 Hold the left mouse button down and drag the mouse to resize the row
or column. Release the left mouse button when you’re happy with the
size of the row or column.
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 Using the mouse to resize a row or column can be fast, but if you
want to resize a row or column to a specific height or width, you
can type the specific dimensions by following these steps:

 Select the row, column, or table that you want to modify.

 If you select the entire table, you can adjust the width or height of rows
and columns for the entire table.

 Click the Layout tab under the Table Tools tab.

 Click the Width text box and type a value (or click the up or down
arrow to choose a value).

 Click the Height text box and type a value (or click the up or down
arrow to choose a value).



Inserting Pictures

 Pictures make our text more attractive and readable.
You can insert relevant pictures in your text by following
these steps;

 Place the cursor where you want to insert the picture

 Select the Insert tab on Ribbon

 In Illustrations group click the Picture command;

 It displays 'Insert Picture' dialog box

 Select the desired image

 Click Insert to insert the picture
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Inserting Images from the Web
220

 Place the cursor where you want to insert the picture

 Select the Insert tab on Ribbon

 In Illustrations group click the Picture command;

 Choose Insert→ Online Pictures.

 Click in the Office.com Clip Art search box, type poinsettia, and
press Enter. A selection of pictures that have poinsettia as a
keyword appear in the task pane.

 Scroll through the resulting clips.

 Click one of the clips and then click the Insert button to insert it.
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Insert Shapes

 Word comes with a library of common shapes ready to insert in a 
document. These include basic shapes, such as squares, circles, 
geometric figures, lines, and arrows — plus popular symbols. 

 Graphics professionals refer to these types of images as line art.

 To place some line art in a document, follow these steps:

 Click the Insert tab.

 In the Illustrations group, click the Shapes button.

 The button holds a menu that lists shapes organized by type.

 Choose a predefined shape.

 The mouse pointer changes to a plus sign (+).

 Drag to create the shape.

 The shape is placed into the document, floating in front of the text.
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 At this point, you can adjust the shape: Change its size, location, or colors.

 Use the Drawing Tools Format tab, conveniently shown on the Ribbon while the shape is selected,
to affect those changes.

 Instantly change the image by using the Shape Styles group on the Ribbon’s Drawing Tools
Format tab. Choose a new style from the Shape Gallery.

 Other items in the Shape Styles group affect the selected shape specifically:

 Click the Shape Fill button to set the fill color;

 Use the Shape Outline button to set the shape’s outline color;

 Choose an outline thickness from the Shape Outline button’s menu, on the Weight submenu;

 Use the Shape Effects button to apply 3D effects, shadows, and other fancy formatting to the shape.
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Charts
225

 A chart is a tool you can use to communicate data graphically.

Including a chart in your document can allow your reader to see the

meaning behind the numbers, and it can make showing

comparisons and trends easier.

 Word has several types of charts, allowing you to choose the one

that best fits your data. In order to use charts effectively, you'll need

to understand how different charts are used.

 Word uses a spreadsheet as a placeholder for entering chart data,

much like Excel. The process of entering data is fairly simple,



Adding charts to Word
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 Microsoft Word enables adding charts and graphs of many kinds in
your document, from simple pie charts to 3D surface graphs. To do
this, simply:

1. Place the cursor where you want your chart to appear

2. Go to “Insert” on the main ribbon and select “Chart” from the
“Illustrations” section

3. In the new window, pick the type of chart you want in your document
and click “OK”

4. Your chart will now appear in the position selected and an Excel
spreadsheet window will open (called “Chart in Microsoft Word”)

5. Edit the values and labels in the Excel window to reflect the data
required for your chart
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To change the chart layout:
229

 Word's predefined chart layouts allow you to modify chart
elements—including chart titles, legends, and data labels—to make
your chart easier to read.

 Select the chart you want to modify. The Design tab will appear.

 From the Design tab, click the Quick Layout command.

 Select the desired predefined layout from the menu that appears.

 The chart will update to reflect the new layout.

 To change a chart element (such as the chart title), click the element
and begin typing.



Adding Equations to Word
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 To insert equations in Word from one of the preset equations,

 First place your cursor at the insertion point in your document
where you want the equation to appear.

 Then click the “Insert” tab in the Ribbon. At the right end of
the tab is the “Symbols” button group. Click the drop-down
arrow on the “Equation” button in this button group to then
open the menu of choices.

 Scroll through the “Built-In” section to view the available
preset equations.

 After finding the preset equation to insert, then click it in
either of these areas to insert it into your document.
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 Alternatively, it is possible to insert equations in Word by manually

entering an equation.

 To manually insert an equation, first place your cursor at the insertion

point in your document where you want the equation to appear.

 Then click the “Insert” tab in the Ribbon.

 Then click the “Equation” button in the “Symbols” button group.

 A blank equation is then inserted into your document.
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 The “Equation Tools” contextual tab then appears, with the “Design” tab
selected.

 We can use the “Symbols” and “Structures” button groups, in conjunction
with your keyboard, to then enter your desired equation into the equation
field.

 After inserting equations in Word using either option, click the drop-down
arrow in the equation field to see a menu of options.

 Selecting the “Save as New Equation…” option from the menu adds the
equation to the drop-down menu of the “Equation” button.

 It is possible to choose how the equation looks by selecting the
“Professional” or “Linear” options.
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 The next options, “Change to Inline” or “Change to Display,”
set how to insert the equation into the document.

 Selecting “Display” lets you adjust the equation’s justification
by using the options in the drop-down menu under the
“Justification” option.

 Selecting “Inline” locks the equation to its original insertion
point.

 To delete an equation, select it in your document. Then press
the “Delete” or “Del” key on your keyboard.
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Microsoft Excel: Spread Sheet
237

 MS-Excel is a window based powerful spreadsheet (Worksheet) package.

 Spreadsheet is wonderful analysis tool with automatic recalculation.

 Banking system, payroll system, Sales and stock maintenance also made in

the MS-Excel spreadsheet.

 A spreadsheet is basically a large grid that is separated into rows and

columns.

 Easy evaluation, What if analysis, Chart and report creations are one of

the tools in the MS-Excel.

 Microsoft Excel is a spread sheet program that allows you to perform

various calculations, estimations, and formulations with data.



238

 It is the electronic counter part of a paper ledger sheet which
consists of a grid of columns and rows.

 The total number of rows in excel is 65,536 and min is 256.

 The row is identified by alphabets like A, B,C etc. The column is
identified by numbers or digits.

 It provides various facilities like:

 Inserting charts

 Creating graphs

 Analyzing situations

 Help in decision-making



Features of Excel or Spreadsheet 
239

 Special mathematical, trigonometric, financial and statistical functions are
available. All complicated calculations can be performed vary easily using
these functions.

 The result of a calculations can be accurate.

 Data can also be viewed in the form of graphs.

 The information stored in a worksheet can be transferred to other software
program.

 The entire worksheet or any part, it can be printed in desired format.

 The worksheet is saved can be retrieved and modified later as when
required.



Starting Excel
240

 Click on the start button on the Taskbar.

 To begin Microsoft Excel , goto Start→ All Programs→Microsoft Office → Microsoft

Excel. (or)

 Select Windows Key + R to obtain Run Command, there type Excel and click Ok to

start Microsoft Excel.

 The following excel window displayed on the screen.
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 Creating a Workbook

 Creating a workbook: Menu option

 Creating a workbook: Toolbar option.

 Opening an existing workbook

 Saving workbook

 Closing a workbook

 Components of an Excel Windows
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Title BarName Bar

Row Header

Active Cell

Column Header

Formula Bar

Sheet Scrolls
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 Working with Worksheet

 Entering the Data (Text, Numeric, Logical, Formulas)

 Editing the Cell content.

 Working with rows and Columns

◼ Adjusting Row Height and Column Width

◼ Inserting Rows and Columns

◼ Deleting Rows and Columns

◼ Moving Rows and Columns

◼ Copying Rows and Columns

 Printing in Excel

 Hiding Columns
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 Organizing Worksheets

 Inserting Worksheets

 Moving Worksheets

 Copying Worksheets

 Deleting Worksheets

 Renaming Worksheets

 Charts in Excel



Charts in Excel
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 Excel provides you different types of charts that suit your purpose. Based on the type of data, 
you can create a chart. You can also change the chart type later.

 Excel offers the following major chart types −

 Column Chart

 Line Chart

 Pie Chart

 Doughnut Chart

 Bar Chart

 Area Chart

 XY (Scatter) Chart

 Bubble Chart

 Stock Chart

 Surface Chart

 Radar Chart

 Combo Chart
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 Column Chart: A Column Chart typically displays the categories
along the horizontal (category) axis and values along the vertical
(value) axis. To create a column chart, arrange the data in columns
or rows on the worksheet.

 Line Chart : Line charts can show continuous data over time on an 
evenly scaled Axis. Therefore, they are ideal for showing trends in 
data at equal intervals, such as months, quarters or years.

 In a Line chart −
 Category data is distributed evenly along the horizontal axis.

 Value data is distributed evenly along the vertical axis.
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 Pie Chart :Pie charts show the size of items in one data series, proportional to the

sum of the items. The data points in a pie chart are shown as a percentage of the

whole pie. To create a Pie Chart, arrange the data in one column or row on the

worksheet.

 Doughnut Chart: A Doughnut chart shows the relationship of parts to a whole. It is

similar to a Pie Chart with the only difference that a Doughnut Chart can contain

more than one data series, whereas, a Pie Chart can contain only one data series. A

Doughnut Chart contains rings and each ring representing one data series. To create

a Doughnut Chart, arrange the data in columns or rows on a worksheet.

 Bar Chart : Bar Charts illustrate comparisons among individual items. In a Bar Chart, 

the categories are organized along the vertical axis and the values are organized 

along the horizontal axis. To create a Bar Chart, arrange the data in columns or 

rows on the Worksheet.
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 Area Chart: Area Charts can be used to plot the change over time and draw attention to the
total value across a trend. By showing the sum of the plotted values, an area chart also shows
the relationship of parts to a whole. To create an Area Chart, arrange the data in columns or
rows on the worksheet.

 XY (Scatter) Chart

 XY (Scatter) charts are typically used for showing and comparing numeric values, like scientific,
statistical, and engineering data.

 A Scatter chart has two Value Axes −

 Horizontal (x) Value Axis

 Vertical (y) Value Axis

 It combines x and y values into single data points and displays them in irregular intervals, or
clusters. To create a Scatter chart, arrange the data in columns and rows on the worksheet.

 Place the x values in one row or column, and then enter the corresponding y values in the
adjacent rows or columns.
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 Bubble Chart : A Bubble chart is like a Scatter chart with an additional third column
to specify the size of the bubbles it shows to represent the data points in the data
series.

 Stock Chart: As the name implies, Stock charts can show fluctuations in stock prices.
However, a Stock chart can also be used to show fluctuations in other data, such as
daily rainfall or annual temperatures.

 Surface Chart: A Surface chart is useful when you want to find the optimum
combinations between two sets of data. As in a topographic map, colors and
patterns indicate areas that are in the same range of values.

 Radar Chart: Radar charts compare the aggregate values of several data series. To
create a Radar chart, arrange the data in columns or rows on the worksheet.

 Combo Chart: Combo charts combine two or more chart types to make the data
easy to understand, especially when the data is widely varied. It is shown with a
secondary axis and is even easier to read. To create a Combo chart, arrange the
data in columns and rows on the worksheet.
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 Consider the following Data, 

STUDENT NAME U5CS01MT U5CS02MT U5CS03ET U5CS05ST U5CS01MP U5CS02MP

PRASANTH .A
35 45 10 25 60

30

PRAVEEN KUMAR .M
11 76 79 86 84 31

PRIYANKA .P
28 96 54 60 81

40

RAGHUL .J
91 24 74 24 59

28

ROKESH .P
46 76 64 82 46

32

SHARAN .V
57 74 48 19 59

35

SINDHU .P
60 71 52 32 66

36
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Animations are visual effects for the objects in our PowerPoint presentation. 
Animations bring objects like text, images, or charts on or off your slide. Microsoft calls 
these entrances and exits. An entrance is an animation that brings something onto the 
slide. An exit moves an object off the slide. Use an animation to make an object enter 
or exit your slide (or even move it between spots on a slide.). There are generally two 
types of animations you can use to make your presentation come alive. These are: 

Transitions 

The first type of animation is called transition animation; these are animations added 
in between slides. When we transition from slide 1 to slide 2, we can add an animation 
in between the slides. we can view the different transition options by going to the 
Transitions pane on the PowerPoint ribbon. 

 

(Caption: The Transitions pane in PowerPoint) 

The default view shows 10 transitions, but if we click on the little , then we will see 
many more options like below: 

 

(Caption: More Transition options in PowerPoint – choose from Subtle, Exciting and 
Dynamic Content transition animations) 



Transition animations have additional effect options. we will notice this when you click 
on the transition we want to use. The Effect Options button won’t be grayed out, and 
we can select additional settings. 

For example, I selected ‘Reveal’ as my transition animation. Available effect options 
would be: 

• Smoothly from right 
• Smoothly from left 
• Through black from right 
• Through black from left 

Here’s a screenshot of what it looks like: 

 

(Caption: Effect Options are available for some transition animations in PowerPoint) 

we can also adjust the timing and duration of each transition as well as set how we 
want the slides to advance so that the transition can take place. 

 

(Caption: More settings can be adjusted in the Timing section as well as the Animation 
Pane) 

Feel free to play around with the transition animations and effect options that work 
best with our presentation. 

 

 



Animations 

The second type of animations bring the objects or elements within our slide to life. If 
we want to animate text, an image, shape, graph or chart, this is the type of animation 
that we select. First to click on the object we want to animate, then click on the 
Animations tab. 

 

(Caption: The Animations pane in PowerPoint) 

The default view shows 8 animations, but if we click on the little, then we will see many 
more options like below: 

We can choose from the following types of animations: 

• Entrance animations. The icons for this type of animation are colored green. 
If we use this type of animation for an object, that object will enter the slide 
according to our timing preferences. 

• Exit animations. The icons for this type of animation are colored red. The 
object we have added this animation to will exit the slide. 

• Emphasis animations. The icons for this kind of animation are colored 
yellow. The object won’t enter or exit the slide (unless we have added that 
particular animation to the same object) but will emphasize and draw attention 
to that object. 

• Motion path animations. This type of animation will allow us to move an 
object from one spot to another. we can specify or draw the path we want 
the object to take. 

 



 

(Caption: More Animation options in PowerPoint – choose from Entrance, Exit, 
Emphasis and Motion Paths animations) 

How To Add Animations to PowerPoint In 2 Simple Steps 

To add entrance animations to any object in PowerPoint, here’s what we need to do: 

1. Click on the object we want to animate. In this example, we will use a blue 
smiley face. 

 

(Caption: The blue smiley face we will be animating for this tutorial) 



2. Select the animation we want to use. For this example, we used the entrance 
animation – fade animation. We set the duration to 2.75 seconds. You will notice in 
the screenshot below that the fade animation has no effect options (the button is 
greyed out). 

 

(Caption: The different options available for Fade animation in PowerPoint) 

Here’s what those numbers in the screenshot mean: 

1 – We chose the Fade animation. 

2 – There are no Effect Options for Fade Animation (the button is grayed out and not 
clickable) 

3 – we can adjust settings via the Advanced Animation, Timing, and Animation Pane 
sections 

4 – The number (1) refers to the fact that we’ve added 1 animation to our object (this 
is the Fade animation). 

5 – We can click on the Preview button to preview the animation. 



Computer Networks 

✓ A Computer network is a group of computers linked to each other that enables 

the computer to communicate with another computer and share their resources, 

data, and applications. 

✓ A network consists of two or more computers that are linked in order to share 

resources (such as printers and CDs), exchange files, or allow electronic 

communications. 

✓ The computers on a network may be linked through cables, telephone lines, 

radio waves, satellites, or infrared light beams. 

✓ A computer network can be categorized by their size. A computer network is 

mainly of four types:           

o PAN(Personal Area Network)  

o LAN(Local Area Network)  

o MAN(Metropolitan Area Network)  

o WAN(Wide Area Network) 

✓ PAN(Personal Area Network) 

o Personal Area Network is a network arranged within an individual 

person, typically within a range of 10 meters.  

o Personal Area Network is used for connecting the computer devices of 

personal use is known as Personal Area Network. 

o Personal Area Network covers an area of 30 feet. 

o Personal computer devices that are used to develop the personal area 

network are the laptop, mobile phones, media player and play stations. 

✓ LAN(Local Area Network) 

o Local Area Network is a group of computers connected to each other in 

a small area such as Home, building, office. 

o LAN is used for connecting two or more personal computers through a 

communication medium such as twisted pair, coaxial cable, etc. 

o It is less costly as it is built with inexpensive hardware such as hubs, 

network adapters, and ethernet cables. 

o The data is transferred at an extremely faster rate in Local Area Network. 

o Local Area Network provides higher security. 

✓ MAN(Metropolitan Area Network) 

o A metropolitan area network is a network that covers a larger geographic 

area by interconnecting a different LAN to form a larger network. 

o Government agencies use MAN to connect to the citizens and private 

industries. 

o In MAN, various LANs are connected to each other through a telephone 

exchange line. 

o It has a higher range than Local Area Network (LAN). 

o Cable Television network is the best example for MAN. 

✓ WAN(Wide Area Network) 

o A Wide Area Network is a network that extends over a large 

geographical area such as states or countries. 

o A Wide Area Network is quite bigger network than the LAN. 



o A Wide Area Network is not limited to a single location, but it spans over 

a large geographical area through a telephone line, fibre optic cable or 

satellite links. 

o The internet is one of the biggest WAN in the world. 

o A Wide Area Network is widely used in the field of Business, 

government, and education. 

✓ Internet 

Internet is a network of network that connect computers all over the world. Network 

is an interconnection of systems to share data and information. Internet is a 

collection of government, academic, commercial, individual and other sites. 

With the Internet, it's possible to access almost any information, communicate with 
anyone else in the world, and do much more. 

You can do all of this by connecting a computer to the Internet, which is also called 
going online. When someone says a computer is online, it's just another way of 
saying it's connected to the Internet. 

 

What is the Web? 

The World Wide Web—usually called the Web for short—is a collection of different 
websites you can access through the Internet. A website is made up of related 
text, images, and other resources. Websites can resemble other forms of media—
like newspaper articles or television programs—or they can be interactive in a way 
that's unique to computers. 



The purpose of a website can be almost anything: a news platform, an 
advertisement, an online library, a forum for sharing images, or an educational site 
like us! 

 

Once you are connected to the Internet, you can access and view websites using 
a type of application called a web browser.  

A web browser (commonly referred to as a browser) is a software application for 
accessing information on the World Wide Web.  

When a user requests a web page from a particular website, the web browser 
retrieves the necessary content from a web server and then displays the page on 
the user's device. 

Note: A web browser is not the same thing as a search engine, though the two are 
often confused. For a user, a search engine is just a website that provides links to 
other websites. However, to connect to a website's server and display its web 
pages, a user must have a web browser installed. 

Some of the Frequently used Browsers are 

➢ Google Chrome 
➢ Mozilla Firefox 
➢ Internet Explorer 
➢ Microsoft Edge 
➢ Opera 



➢ Netscape navigator 
➢ Safari 

Functions of Browser 

The purpose of a web browser is to fetch information resources from the Web 
and display them on a user's device. 

This process begins when the user inputs a Uniform Resource Locator (URL), 
such as https://www.apcas.in/, into the browser.  

Virtually all URLs on the Web start with either http: or https: which means the 
browser will retrieve them with the Hypertext Transfer Protocol (HTTP).  

In the case of https: the communication between the browser and the web 
server is encrypted for the purposes of security and privacy. 

Once a web page has been retrieved, the browser's rendering engine displays 
it on the user's device. This includes image and video formats supported by the 
browser. 

Web pages usually contain hyperlinks to other pages and resources. Each link 
contains a URL, and when it is clicked or tapped, the browser navigates to the 
new resource. Thus, the process of bringing content to the user begins again. 

Most browsers use an internal cache of web page resources to improve loading 
times for subsequent visits to the same page. The cache can store many items, 
such as large images, so they do not need to be downloaded from the server 
again. Cached items are usually only stored for as long as the web server 
stipulates in its HTTP response messages. 

✓ Internet Services 

o E-mail: This service has been available since the early days of the 

ARPANET and its enormous popular. Email enables people to send 

messages as well as files to one or more people. 

o Mailing Lists: enables groups of people to conduct group conversations 

by email. 

o News: Usenet Newsgroups are specialized forums in which users with 

common interest can exchange messages. It enables online group 

discussions to occur, using a system of news server to store messages 

of 10,000. 

o Remote login: Users on the internet can log into any other machine on 

the internet on which they have account. 

o File Transfer: Users can copy files from one machine on the internet to 

another. 

o Online Chat- Provides a way for real time online chatting to occur, where 

participants read each other messages. 



o Voice and Video Conferencing: Two or more people to hear and see 

each other, with the help of camera fixed over these and share other 

applications. 

o Internet Telephony (VoIP): Allows the internet users to talk across 

internet to any PC equipped to receive the call. 

o Browser: Contains the basic software that can retrieve, view and send 

information over the internet. 

o Download: To copy data from a remote computer to the local computer. 

o Upload:  To send data from local computer to remote computer. 

✓ Email Basics 

o Email is a service which allows us to send the message in electronic 

mode over the internet. It offers an efficient, inexpensive and real time 

mean of distributing information among people. 

o Each user of email is assigned a unique name for his email account. This 

name is known as E-mail address. Different users can send and receive 

messages according to the e-mail address. 

o E-mail is generally of the form username@domainname. For example, 

apcasgbn19@gmail.com is an e-mail address where apcasgbn19 is 

username and gmail.com is domain name. 

o The username and the domain name are separated by @ (at) symbol. 

o E-mail addresses are not case sensitive. 

o Spaces are not allowed in e-mail address. 

o Components of E-mail Message  

o E-mail message comprises of different components: E-mail Header, 

Greeting, Text, and Signature.  

o E-mail Header: The first five lines of an E-mail message is called E-mail 

header.  

o The header part comprises of following fields: 

▪ From: The From field indicates the sender’s address i.e. who sent 

the e-mail. 

▪ Date: The Date field indicates the date when the e-mail was sent. 

▪ To: The To field indicates the recipient’s address i.e. to whom the 

e-mail is sent. 

▪ Subject: The Subject field indicates the purpose of e-mail. It 

should be precise and to the point. 

▪ CC: CC stands for Carbon copy. It includes those recipient 

addresses whom we want to keep informed but not exactly the 

intended recipient. 

▪ BCC: BCC stands for Black Carbon Copy. It is used when we do 

not want one or more of th e recipients to know that someone 

else was copied on the message. 

▪ Greeting: Greeting is the opening of the actual message.  

▪ Text: It represents the actual content of the message. 

▪ Signature: This is the final part of an e-mail message. It includes 

Name of Sender, Address, and Contact Number. 



▪ Attachment: Ability to attach file(s) along with the message is 

one of the most useful features of email. The attachment may be 

a word document, PowerPoint presentation, audio/video files, or 

images. The maximum size allowed is 25 MB. 

✓ Advantages of Email 

o Productivity tools: Email is usually packaged with a calendar, address 

book, instant messaging, and more for convenience and productivity. 

o Access to web services: If you want to sign up for an account like 

Facebook or order products from services like Amazon, you will need an 

email address so you can be safely identified and contacted. 

o Easy mail management: Email service providers have tools that allow 

you to file, label, prioritize, find, group, and filter your emails for easy 

management. You can even easily control spam, or junk email. 

o Privacy: Your email is delivered to your own personal and private 

account with a password required to access and view emails. 

o Communication with multiple people: You can send an email to 

multiple people at once, giving you the option to include as few as or as 

many people as you want in a conversation. 

o Accessible anywhere at any time: You don’t have to be at home to get 

your mail. You can access it from any computer or mobile device that 

has an Internet connection. 

o Reliable: Many of the mail systems notify the sender if e-mail message 

was undeliverable. 

o Speed: E-mail is very fast. However, the speed also depends upon the 

underlying network. 

o Inexpensive: The cost of sending e-mail is very low. 

o Printable: It is easy to obtain a hardcopy of an e-mail. Also an electronic 

copy of an e-mail can also be saved for records. 

o Global: E-mail can be sent and received by a person sitting across the 

globe. 

o Generality: It is also possible to send graphics, programs and sounds 

with an e-mail. 

✓ Disadvantages 

o Apart from several benefits of E-mail, there also exists some 

disadvantages as discussed below: 

▪     Forgery 

▪     Overload 

▪     Misdirection 

▪     Junk 

▪     No response 

Creating a new email account 

To create a Gmail address, you'll first need to create a Google account. Gmail will 
redirect you to the Google account sign-up page. You'll need to provide some basic 
information like your name, birth date, gender, and location. You will also need to 



choose a name for your new Gmail address. Once you create an account, you'll be 
able to start adding contacts and adjusting your mail settings. 

To create an account: 

1. Go to www.gmail.com. 
2. Click Create account. 

 

3. The sign-up form will appear. Follow the directions by entering the required 
information. 

http://www.gmail.com/


 

4. Next, enter your phone number to verify your account. Google uses a two-step 
verification process for your security. 

5. You will receive a text message from Google with a verification code. Enter 
the code to complete the account verification.  

 



6. Next, you will see a form to enter some of your personal information, like your 
name and birthday.  

7. Review Google's Terms of Service and Privacy Policy, then click I agree. 
8. Your account will be created. 

Signing in to your account 

When you first create your account, you will be automatically signed in. Most of the 
time, however, you'll need to sign in to your account and sign out when you're done 
with it. Signing out is especially important if you're using a shared computer (for 
example, at a library or office) because it prevents others from viewing your emails. 

To sign in: 

1. Go to www.gmail.com. 
2. Type your user name (your email address) and password, then click Next. 

 

To sign out: 

In the top-right corner of the page, locate the circle that has your first initial (if you've 
already selected an avatar image, it will show the image instead). To sign out, click 
the circle and select Sign out.  

http://www.google.com/intl/en/policies/terms/
http://www.google.com/intl/en/policies/privacy/
http://www.gmail.com/


Sending email 

When you write an email, you'll be using the compose window. This is where you'll 
add the email address of the recipient(s), the subject, and the body of the email, 
which is the message itself. You'll also be able to add various types of text formatting, 
as well as one or more attachments. If you want, you can even create a signature 
that will be added to the end of every email you send. 

The compose window 

Click the buttons in the interactive below to learn about the different parts of the 
compose window. 

To send an email: 

1. In the left menu pane, click the Compose button. 

 

2. The compose window will appear in the lower-right corner of the page. 

 



3. You'll need to add one or more recipients to the To: field. You can do this by 
typing one or more email addresses, separated by commas, or you can click 
To to select recipients from your contacts, then click select. 

 

4. Type a subject for the message. 
5. In the body field, type your message. When you're done, click Send. 



 

If the person you are emailing is already one of your contacts, you can start typing that 
person's first name, last name, or email address, and Gmail will display the contact 
below the To: field. You can then press the Enter key to add the person to the To: 
field. 

Adding attachments 

An attachment is simply a file (like an image or document) that is sent along with your 
email. For example, if you are applying for a job, you might send your resume as an 
attachment, with the body of the email being the cover letter. It's a good idea to 
include a message in the body of your email explaining what the attachment is, 
especially if the recipient isn't expecting an attachment. 

Remember to attach your file before you click Send. Forgetting to attach a file is a 
surprisingly common mistake. 

To add an attachment: 

1. While composing an email, click the paper clip icon at the bottom of the 
compose window. 

2. A file upload dialog box will appear. Choose the file you want to attach, then 
click Open. 



 

3. The attachment will begin to upload. Most attachments will upload within a few 
seconds, but larger ones can take longer. 

4. When you're ready to send your email, click Send. 

You can click Send before the attachment finishes uploading. It will continue to upload, 
and Gmail will automatically send the email once it's done. 

Email formatting 

Gmail allows you to add various types of formatting to your text. 

Click the formatting button at the bottom of the compose window to see different 
formatting options. 

 

Click the buttons in the interactive below to learn about different formatting options in 
Gmail. 



Reading email 

By default, any email we receive will go to our inbox. You'll be able to tell which emails 
are unread because they'll be bold. You can also see the name of the sender, the 
subject of the email, and the first few words of the email body. This means even 
before you select an email, you can tell quite a few things about it. 

To read an email: 

1. From your inbox, click the email you want to read. 

 

2. The email will open in the same window. 

• You can Reply, Reply to all, or Forward the email to someone else. 

 

• You can click Newer or Older on the right side of the window to view the next 
email (or previous one). 

 

• You can go Back to Inbox. 



Opening attachments 

Sometimes you'll receive emails that contain attachments. Generally, you will need 
to download an attachment to view it. However, many common file types, like Word 
documents and images, can be viewed within a browser window. If the attachment 
is an image, you'll also see a smaller copy of the image—called a thumbnail—inside 
the body of the email. You can tell which emails contain attachments because they will 
have a paper clip icon to the right of the subject. 

To open an attachment: 

1. Open the email message that contains the attachment. 

 

2. Click the Download icon to save the attachment to your computer. If your 
computer asks whether you want to Open or Save it, choose Save. You can 
then locate the file on your computer and double-click it to open it.  

You should generally only open an attachment if it's from a trusted source. Some 
attachments can contain viruses, especially .exe files. If you don't recognize the 
sender—or if you don't know why someone is sending you the attachment—it's safest 
not to open it. For more information, read our lesson on avoiding spam and phishing 
from our Internet Safety tutorial. 

Replying to emails 

Most of the time, you will be replying to an email someone else sends you instead of 
composing a new message. When you reply, the recipient's email address will 
automatically appear in the To: field, so you won't need to worry about choosing the 
recipient. 

 

Sometimes you'll receive emails where you're not the only recipient, and you'll need 
to decide whether you want to reply just to the person who sent the message or 
reply to all (the sender and all recipients). For example, if you're collaborating with a 
group of people via email, you'll probably want to use the Reply to all option so 
everyone gets the message. However, if you want to send a more private message to 
the sender, you'll need to select the Reply option so the message stays between the 
two of you. 



To reply to an email message: 

1. While viewing the message, click Reply at the bottom of the message. If the 
message was sent to multiple recipients, you will also have the option to Reply 
to all. You can also click the Reply arrow to respond to the message. 

2. You may want to double-check the To: and Cc: fields to make sure you're 
sending your message to the correct people. If you are replying to all 
recipients, the additional recipients will appear in the Cc: field. 

3. Type your message in the Body field, then click Send. 

To see the text of the original email while you're replying, click the gray button in the 
lower-left corner of the window, right above the Send button. 

Forwarding emails 

You can also choose to forward an email. This basically works the same as replying, 
but it's used to send the email to someone who wasn't one of the original recipients. 
Just like a reply, the original message will appear as a quote. It's usually a good idea 
to include a brief message of your own to explain why you're forwarding the email. 

To forward an email message: 

1. While viewing the message, click Forward at the bottom of the message. You 
can also select Forward from the More drop-down menu next to the Reply 
arrow. 

2. Type the recipient's email address in the To: field, or click To to choose a 
recipient from your contacts. If the person is in your contacts, you can start 
typing his or her name and that contact's email address should appear. 

3. Type your message in the Body field, then click Send. 

Search Engines 

A search engine is a software program that helps people find the information they are 

looking for online using keywords or phrases. 

Search engines are able to return results quickly—even with millions of websites 

online—by scanning the Internet continuously and indexing every page they find. 

When a user enters a query into a search engine, a Search Engine Results Page 

(SERP) is returned, ranking the found pages in order of their relevance. How this 

ranking is done differs across search engines. 

Search engines often change their algorithms (the programs that rank the results) to 

improve user experience. They aim to understand how users search and give them 

the best answer to their query. This means giving priority to the highest quality and 

most relevant pages. 

How do search engines work? 

There are three key steps to how most search engines work: 



➢ Crawling - search engines use programs, called spiders, bots or crawlers, to 

scour the internet. They may do this every few days, so it is possible for content 

to be out-of-date until they crawl your website again.  

➢ Indexing - the search engine will try to understand and categorise the content 

on a web page through 'keywords'. Following SEO best practice will help the 

search engine understand your content so you can rank for the right search 

queries.  

➢ Ranking - search results are ranked based on a number of factors. These may 

include keyword density, speed and links. The search engine's aim is to provide 

the user with the most relevant result.  

Although most search engines will provide tips on how to improve your page ranking, 

the exact algorithms used are well guarded and change frequently to avoid misuse. 

But by following search engine optimisation (SEO) best practice you can ensure that: 

Search engines can easily crawl your website. You can also prompt them to 

crawl new content. Your content is indexed for the right keywords so it can appear for 

relevant searches. Your content can rank highly on the SERP. 

How to search the Web 

There are many different search engines we can use, but some of the most popular 
include Google, Yahoo!, and Bing. To perform a search, we need to navigate to a 
search engine in our web browser, type one or more keywords—also known as 
search terms—then press Enter on your keyboard. In this example, we'll search for 
recipes. 

 

After we run a search, we got a list of relevant websites that match our search terms. 
These are commonly known as search results. If we got a result that looks interesting 



and match our interest, then we can click a link to open it. If the site doesn't have what 
we need, then we can simply return to the results page to look for more options. 

 

Most browsers also allow us to perform a web search directly from our address bar, 
although some have a separate search bar next to the address bar. Simply type our 
search terms and then press Enter to run the search. 

 

Search suggestions 

If we don't find what we are looking for on the first try, don't worry! Search engines are 
good at finding things online, but they're not perfect. We will often need to try different 
search terms to find what we are looking for. 

If we are having trouble thinking of new search terms, then we can use search 
suggestions instead. These will usually appear as you're typing, and they're a great 
way to find new keywords we might not have tried otherwise. To use a search 
suggestion, we can click it with our mouse, or select it with the arrow keys on our 
keyboard. 



 

Refining our search 

If we are still having trouble finding exactly what we need, then we can use some 
special characters to help refine our search. For example, if we want to exclude a 
word from a search, we can type a hyphen (-) at the beginning of a word. Suppose, 
we wanted to find cookie recipes that don't include chocolate, then we could search 
for recipes cookies -chocolate. 

 

we can also search for exact words or phrases to narrow down our results even 
more. All we need to do is place quotation marks (" ") around the desired search 
terms. For example, if we want to search for recipes "sugar cookies", our search 
results will only include recipes for sugar cookies, instead of any cookies that happen 
to use sugar as an ingredient. 



 

These techniques may come in handy in certain cases, but we probably won't need to 
use them with most searches. Search engines can usually figure out what we are 
looking for without these extra characters. We recommend trying a few different 
search suggestions before using this method.  

Content-specific searches 

There may be times when we are looking for something more specific, like a news 
article, picture, or video. Most search engines have links at the top of the page that 
allow you to perform these unique searches. 

 

In the example below, we've used the same search terms to look for images instead 
of websites. If we saw an image what we like, then we can click to visit the website it 
originally came from.  



 

we can use the extra search tools to narrow down your results even more. These 
tools will change based on the type of content what we are looking for, but in this 
example we can filter our images by size, color, image type, and more. So if we 
wanted to find cookies with pink frosting, then search for images that are mostly pink. 

 
 


